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BAB I 

PENDAHULUAN 

 

1.1 Latar  Belakang 

Perkembangan zaman era globalisasi sekarang ini system informasi dengan 

menggunakan teknologi computer yang sangat canggih dan modern akan 

memudahkan kita untuk melakukan pengolahan data yang dapat menghemat 

waktu, ruang dan biaya. Sehingga hasil suatu informasi yang diperoleh akan 

sangat memuaskan, berguna dan bermanfaat dari suatu lembaga atau instansi 

yang menggunakannya. Pengolahan data dan informasi secara cepat, tepat dan 

efisien adalah hal penting yang dibutuhkan bagi lembaga atau instansi, yaitu 

salah satunya adalah  Perusahaan Daerah Air Minum ( PDAM)  Tirta Naga. 

Seiring diterapkannya teknologi informasi spasial atau geografi yang 

berorientasi pada penggunaan teknologi komputer, Perusahaan Daerah Air Minum 

( PDAM)  dapat terbantu dengan membuat catatan tentang pelanggan yang masih 

aktif memakai satuan meter. Sebagai sistem berbasis komputer yang memiliki 

kemampuan dalam menangani data bereferensi geografi yaitu pemasukan data, 

manajemen data (penyimpanan dan pemanggilan kembali), memanipulasi dan 

analisis data, serta keluaran sebagai hasil akhir output, sehingga mempermudah 

mendapatkan informasi yang telah di olah dan tersimpan sebagai atribut suatu 

lokasi atau objek.Sebagai perusahaan yang memiliki data pelanggan yang cukup 

banyak atau membantu untuk mengetahui letak posisi suatu pelanggan sehingga 

dapat memberikan kemudahan, kecepatan dan akurasi dalam melakukan 
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pengecekan data pelanggan Perusahaan Daerah Air Minum ( PDAM) Tirta Naga 

Kota Tapak Tuan di Desa Lhok Bengkuang  dalam kepentingan evaluasi, 

pengendalian dan pemantauan, perlu dibangun sebuah layanan Sistem Informasi 

Geografis (SIG) sehingga memberikan informasi yang maksimal seperti, 

menampilkan data dalam suatu informasi berbasis geografis. 

Dalam menyelesaikan masalah tersebut hal-hal yang sangat perlu 

diperhatikan adalah bagaimana merancang peta yang baik agar mudah di pahami 

dengan baik.  Atas dasar dan landasan di atas maka penulis tertarik untuk 

membuat penelitian dalam bentuk laporan dengan judul ”Pemetaan Pipa Air 

Pelanggan Perusahaan Daerah Air Minum ( PDAM) Tirta Naga 

Menggunakan Software ArcGIS 9.3 Studi Kasus Desa Lhok Bengkuang Kota 

Tapak Tuan.” 

 

1.2 Rumusan Masalah 

Berdasarkan latar belakang permasalahan yang telah di uraikan diatas,maka 

dapat dirumuskan suatu permasalahanyaitu: 

a. Bagaimana cara pemetaan pipa air, pendigitasian dan pengolahan data 

dengan menggunakan perangkat lunak ArcGIS 9,3 kepada pelanggan 

Perusahaan Daerah Air Minum ( PDAM) Tirta Naga Kota Tapak Tuan di 

Desa Lhok Bengkuang. 

b. Memberikan informasi yang maksimal dan tepat akurat seperti, menampilkan 

data dalam suatu informasi berbasis geografis. 
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1.3Batasan Masalah 

Agar penelitian dalam tugas akhir ini lebih terarah dan memudahkan 

dalam suatu pembahasan, maka perlu adanya pembatasan masalah, yaitu: 

1. Sistem informasi ini menggunakan software ArcGIS 9.3  untuk memetaka 

pipa air . 

2. Pada penelitian ini penulis tidak membahas lokasi pemetaan secara 

keseluruhan pelanggan di Kota Tapak Tuan, tetapi hanya di Desa Lhok 

Bengkuang. 

3. Pada penilitian ini penulis tidak membahas data detail pelanggan. 

 

1.4Tujuan Penelitian 

Tujuan dari penelitian ini adalah: 

1. Pendigitasian dan pengolahan dataserta pembuatan peta tematik dengan 

menggunakan perangkat lunak  ArcGIS 9,3 kepada pelanggan Perusahaan 

Daerah Air Minum ( PDAM)  Tirta Naga Desa Tapak Tuan sehingga 

memberikan informasi yang maksimal seperti, menampilkan data dalam 

suatu informasi berbasis geografis.  

2. Memberikan kemudahan pegawai untuk mengidentifikasi data  maupun pipa 

pelanggan  Perusahaan Daerah Air Minum ( PDAM)  dan memberikan 

kemudahan, kecepatan dan akurasi dalam melakukan  pengecekan pipa. 

 

1.5 Manfaat  

Manfaat penelitian antara lain:  
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1. Memberikan informasi kemudahan, kecepatan dan akurasi dalam melakukan 

pengecekan pipa pelanggan Perusahaan Daerah Air Minum ( PDAM) Tirta 

Naga Kota Tapak Tuan di Desa Lhok Bengkuang untuk kepentingan 

evaluasi, pengendalian dan pemantauan. 

2. Membantu instansi untuk memetakan pipa pada kawasan desa yang terdaftar 

sebagai pelanggan yang masih aktif. 

3. Diharapkan hasil dari penelitian ini yang dibuat oleh penulis dapat menambah 

pengetahuan bagi penulis dan orang lain. 
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BAB II 

TINJAUAN PUSTAKA 
 
 

2.1  Pengertian Peta 

Peta adalah gambaran sebagian atau seluruh muka bumi baik yang terletak di 

atas maupun di bawah permukaan dan disajikan pada bidang datar pada skala dan 

proyeksi tertentu (secara matematis). Karena dibatasi oleh skala dan proyeksi 

maka peta tidak akan pernah selengkap dan sedetail aslinya (bumi), karena itu 

diperlukan penyederhanaan dan pemilihan unsur yang akan ditampilkan pada 

peta. 

Terdapat beberapa definisi yang dikemukakan oleh para ahli, yaitu: 

1. Menurut International Cartographic Association (ICA) Peta adalah gambaran 

atau representasi unsur-unsur ketampakan abstrak yang dipilih dari 

permukaan bumi yang ada kaitannya dengan permukaan bumiatau benda-

benda angkasa, yang pada umumnya digambarkan pada suatu bidang datar 

dan diperkecil/diskalakan. 

2. Menurut Aryono Prihandito (1988:18) Peta merupakan gambaran permukaan 

bumi dengan skala tertentu, digambar pada bidang datar melalui sistem 

proyeksi tertentu. 

3. Menurut Erwin Raisz (1948:4) Peta adalah gambaran konvensional dari 

ketampakan muka bumi yang diperkecil seperti ketampakannya kalau dilihat 

vertikal dari atas, dibuat pada bidang datar dan ditambah tulisan-tulisan 

sebagai penjelas. 
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4. Menurut Badan Koordinasi Survei dan Pemetaan Nasional (Bakosurtanal 

2005:23) Peta merupakan wahana bagi penyimpanan dan penyajian data 

kondisi lingkungan, merupakan sumber informasi bagi para perencana dan 

pengambilan keputusan pada tahapan dan tingkatan pembangunan. Dengan 

menggunakan peta, kita dapat mengetahui segala hal yang berada di 

permukaan bumi, seperti letak suatu wilayah, jarak antar kota, lokasi 

pegunungan, sungai, danau, lahan persawahan, jalan raya, bandara, dan 

sebagainya. Ketampakan yang digambar pada peta dapat dibagi menjadi dua 

yaitu ketampakan alami dan ketampakan buatan manusia (budaya). Dewasa 

ini sudah dikenal adanya peta digital (Digital Map), yaitu peta yang berupa 

gambaran permukaan bumi yang diolah dengan bantuan media komputer. 

Data yang diperoleh berupa data digital dan hasil dari gambaran tersebut 

dapat disimpan dalam suatu media seperti disket, CD, maupun media 

penyimpanan lainnya, serta dapat ditampilkan kembali pada layar monitor 

komputer. Biasanya peta digital ini dibuat dengan menggunakan software 

Geography Information System (GIS). Ilmu yang mempelajari tentang peta 

dan pemetaan disebut dengan kartografi dan orang yang ahli dalam bidang 

peta dan pemetaan disebut kartograf. 

 

2.2 Sistem Informasi 

Sistem informasi tidak harus melibatkan komputer. Sistem informasi yang 

menggunakan komputer biasa disebut sistem informasi berbasis komputer 

Computer Based Information Systems ( CBIS).  
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Dalam prakteknya, istilah sistem informasi lebih sering dipakai tanpa embel-

embel berbasis komputer walaupun dalam kenyataan komputer merupakan bagian 

yang penting.  

Sistem informasi adalah sistem informasi yang berbasis komputer. Terdapat 

beberapa definisi yang dikemukakan oleh para ahli, yaitu : 

1. Bodnar dan Hopwood (1993:27)sistem informasi adalah kumpulan perangkat 

keras dan lunak yang dirancang untuk mentransformasikan data ke dalam 

bentuk informasi yang berguna. 

2. Gelinas, Oram, dan Wiggins (1999:37) sistem informasi adalah sesuatu 

sistem buatan manusia yang secara umum terdiri atas sekumpulan komponen 

berbasis komputer dan manual yang dibuat untuk menghimpun, menyimpan, 

dan mengelola data serta menyediakan informasi  kepada para pemakai. 

3. Wilkinson (1992:31) sistem informasi adalah kerangka kerja yang 

mengkoordinasikan sumber daya (manusia, komputer) untuk mengubah 

masukan (input) menjadi keluaran (informasi), guna mencapai sasaran-

sasaran perusahaan. 

4. Alter (1992:17) sistem informasi adalah kombinasi antara prosedur kerja, 

informasi, orang dan teknologi informasi yang diorganisasikan untuk 

mencapai tujuan dalam sebuah organisasi. 

 

2.3  Pengertian Sistem Informasi Geografis (SIG) 

Sistem Informasi Geografis (SIG) atau Geographic Information System (GIS) 

yang selanjutnya akan disebut Sistem Informasi Geografis (SIG) merupakan 
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sistem informasi berbasis komputer yang digunakan untuk mengolah dan 

menyimpan data atau informasi geografis (Aronoff, 1989:23). Secara umum 

pengertian Sistem Informasi Geografis (SIG) sebagai berikut:” Suatu komponen 

yang terdiri dari perangkat keras, perangkat lunak, data geografis dan sumber 

daya manusia yang bekerja bersama secara efektif untuk memasukan, 

menyimpan, memperbaiki, memperbaharui, mengelola, memanipulasi, 

mengintegrasikan, menganalisa dan menampilkan data dalam suatu informasi 

berbasis geografis. 

Terdapat beberapa  definisi Sistem Informasi Geografis (SIG) antara lain: 

1. Menurut Aronaff (1989:23) Sistem Informasi Geografis (SIG) adalah sistem 

informasi yang didasarkan pada kerja komputer yang memasukkan, 

mengelola, memanipulasi dan menganalisa data serta memberi uraian. 

2. Menurut Murai (1999:11)Sistem Informasi Geografis (SIG) sebagai sistem 

informasi yang digunakan untuk memasukkan, menyimpan, memanggil 

kembali, mengolah, menganalisis dan menghasilkan data bereferensi 

geografis atau data geospatial, untuk mendukung pengambilan keputusan 

dalam perencanaan dan pengelolaan penggunaan lahan, sumber daya alam, 

lingkungan, transportasi, fasilitas kota, dan pelayanan umum lainnya. 

3. Menurut Bernhardsen (2002:37)Sistem Informasi Geografis (SIG) sebagai 

sistem komputer yang digunakan untuk memanipulasi data geografis. Sistem 

ini diimplementasikan dengan perangkat keras dan perangkat lunak komputer 

yang berfungsi untuk  verifikasi data, kompilasi data, penyimpanan data, 
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perubahan dan pembaharuan data, manajemen dan pertukaran data, 

manipulasi data, pemanggilan dan presentasi data serta analisa data. 

Berdasarkan beberapa definisi tersebut, dapat disimpulkan bahwa Sistem 

Informasi Geografis (SIG) mencangkup sejumlah komponen (manusia, 

komputer, teknologi informasi dan prosedur kerja), ada sesutu yang diproses  

(data menjadi informasi) dan dimaksudkan untuk mencapai suatu sasaran atau 

tujuan. 

Sistem Informasi Geografis (SIG) mempunyai kemampuan untuk 

menghubungkan berbagai data pada suatu titik tertentu di bumi, 

menggabungkannya, menganalisa dan akhirnya memetakan hasilnya. Data yang 

akan diolah pada Sistem Informasi Geografis (SIG) merupakan data spasial 

,yaitu sebuah data yang berorientasi geografis dan merupakan lokasi yang 

memiliki sistem koordinat tertentu. 

 

2.4 Data Spasial 

Sebagian besar data yang akan ditangani dalam Sistem Informasi Geografis 

(SIG) merupakan Data Spasial yaitu sebuah data yang berorientasi geografis, 

memiliki sistem koordinat tertentu sebagai dasar referensinya dan mempunyai dua 

bagian penting yang membuatnya berbeda dari data lain, yaitu informasi lokasi 

(spasial) dan informasi deskriptif (attribute) yang dijelaskan berikut ini: 

1. Informasi lokasi (spasial), berkaitan dengan suatu koordinat baik koordinat 

geografi (lintang danbujur) dan koordinat XYZ, termasuk diantaranya 

informasi data dan proyeksi. 
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2. Informasi deskriptif (atribut) atau informasi non spasial, suatu lokasi yang 

memiliki beberapa keterangan yang berkaitan dengannya, contohnya: jenis 

vegetasi, populasi, kode pos dan sebagainya. 

 

2.5Format Data Spasial 

Secara sederhana format dalam bahasa komputer berarti bentuk dan kode 

penyimpanan data yang berbeda antara file satu dengan lainnya. Dalam Sistem 

Informasi Geografis (SIG), data spasial dapat direpresentasikan dalam dua 

format, yaitu: 

1. Data vektor  

Data vektor merupakan bentuk bumi yang direpresentasikan ke dalam 

kumpulan garis, area (daerah yang dibatasi oleh garis yang berawal dan 

berakhir pada titik yang sama), titik dan nodes (merupakan titik perpotongan 

antara dua buah garis). Keuntungan utama dari format data vektor adalah 

ketepatan dalam merepresentasikan fitur titik, batasan dan garis lurus. Hal ini 

sangat berguna untuk analisa yang membutuhkan ketepatan posisi, misalnya 

pada basisdata batas-batas kadaster. Contoh penggunaan lainnya adalah 

untukmendefinisikan hubungan spasial dari beberapa fitur. Kelemahan data 

vektor yang utama adalah ketidak mampuannya dalam mengakomodasi 

perubahan gradual, gambarnya dapat dilihat pada Gambar 2.1; 
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Gambar 2.1 Data vektor 

2. Data Raster  

Data raster (atau disebut juga dengan sel grid) adalah data yang dihasilkan dari 

sistem penginderaan jauh. Pada data raster, obyek geografis direpresentasikan 

sebagai struktur sel grid yang disebut dengan pixel (picture element), gambarnya 

dapat dilihat pada Gambar 2.2; 

 Gambar 2.2 Data Raster  

Pada data raster, resolusi (definisi visual) tergantung pada ukuran pixelnya. 

Dengan kata lain, resolusi pixel menggambarkan ukuran sebenarnya di 

permukaan bumi yang diwakili oleh setiap pixe lpada citra. Semakin kecil ukuran 

permukaan bumi yang direpresentasikan oleh satu sel, semakin tinggi resolusinya. 

Data raster sangat baik untuk merepresentasikan batas-batas yang berubah secara 

gradual, seperti jenis tanah, kelembaban tanah, vegetasi, suhu tanah dan 

sebagainya. Keterbatasan utama dari data raster adalah besarnya ukuran file, 
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semakin tinggi resolusigridnya semakin besar pula ukuran filenya dan sangat 

tergantung pada kapasitas perangkat keras yang tersedia. Masing-masing format 

data mempunyai kelebihan dan kekurangan.  

Pemilihan format data yangdigunakan sangat tergantung pada tujuan 

penggunaan, data yang tersedia, volume data yangdihasilkan, ketelitian yang 

diinginkan, serta kemudahan dalam analisa. Data vektor relatif lebih ekonomis 

dalam hal ukuran file dan presisi dalam lokasi, tetapi sangat sulit untuk digunakan 

dalam komputasi matematik. Sedangkan data raster biasanya membutuhkan 

ruang penyimpanan file yang lebih besar dan presisi lokasinya lebih rendah, tetapi 

lebih mudah digunakan secara matematis. 

 

2.6 Sekilas Mengenai Software ArcGIS 9.3 

ArcGIS adalah suatu perangkat lunak yang di desain pada Graphical User 

Interface (GUI) untuk pengolahan data spasial menjadi Sistem Informasi 

Geografis (SIG). Melalui perangkat lunak ini, dapat melakukan display , eksplore, 

queri, dan analisa data spasial serta data-data tabuler yang menyertainya. 

Didesain pada windows Desktop seperti Windows NT, Windows 2000,Windows 

XP, Window Vista dan Windows 7. Perangkat lunak ini memiliki 4 Aplikasi 

standar yaitu ArcMap, ArcCatalog, ArcGlobe dan ArcToolbox. ArcGIS 

menyediakan aplikasi yang bisa disesuailkan dengan kemampuan dan kebutuhan 

penggunanya. 

1. ArcMap: didesain untuk menampilkan data, editing, analisi spasial dan 

pencetakan peta kualitas tinggi  
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2. ArcCatalog: berfungsi untuk mengakses dan mengatus manajemen data (data 

spasial dan non spasial) dengan mudah. Pengguna bisa mencari data yang 

diinginkan. 

3. Menampilkannya, melihat atau membuat datanya. ArcCatalog juga bisa 

mengakses database eksternal (Ms Access, SQL Server, Oracle, dsb).  

4. ArcGlobe: didesain untuk menampilkan data secara 3 dimensi.  

5. ArcToolbox: berisi tools (alat-alat) untuk berbagai macam geoprocessing 

serta konversi antar format data. 

 

2.7 Memulai dan Membuka Project 

Adapun langkah memulai dan membuka project, sebagai berikut: 

1. Buka aplikasi ArcMap, Klik Start, pilih Program, sorot ArcGIS dan pilih, 

gambarnya dapat dilihat pada Gambar 2.3; 

 

 

 

 

 

Gambar 2.3 ArcMap   

2. ArcMap atau double klik icon; 
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3. Kemudian muncul Arc Map Startup dialog box. Bila akan membuka 

lembaran kerja baru pilih a new empty map dan bila kita akan membuka 

peta yang telah dibuat sebelumnya pilih Open an existing map, gambarnya 

dapat dilihat pada Gambar 2.4; 

 

 

 

 

 

 

 

 

 

 

   Gambar 2.4 Pilihan ArcMap 

4. Akan muncul satu data frame sebagai berikut, gambarnya dapat dilihat pada 

Gambar 2.5; 

 

 

 

 

 

 

Gambar 2.5 data frame 

5. Tables of Content; 
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Setiap peta memiliki table of content. Beberapa peta menampilkan seluruh 

layer pada satu data frame.Table of contentakan menampilkan bagaimana 

layer-layer disusun dalam satu data frame. Ketika menampilkan peta, 

biasanya kita akan menggunakan table of contentuntuk mengaktifkan 

ataupun menonaktifkan sebuah layer.  

Pada saat kita ingin membentuk sebuah peta maka yang akan banyak 

berfungsi adalah table of content termasuk dalam menambahkan, menghapus 

dan menentukan bagaimana layer ditampilkan. 

Cara / langkah menampilkan Table of Content:  

1. Klik menu View, pada toolbar standard; 

2. Klik table of content; 

3. Akan muncul Table of Content, gambarnya dapat dilihat pada Gambar 

2.6; 

 

 

 

 

 

Gambar 2.6 table of content 

6. Menampilkan Data View dan Lay Out View; 

a. Data Viewberguna untuk menampilkan data dan mengeksplore data, cara 

memunculkannya adalah dengan mengklik gambarnya pada bagian 

bawah data frame, gambarnya dapat dilihat pada Gambar 2.7; 
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Gambar 2.7data view 

b. Lay Out View berguna untuk mempersiapkan peta pada saat akan di lay out, 

untuk disisipkan pada laporan dan untuk mempublikasikannya pada web, 

gambarnya dapat dilihat pada Gambar 2.8; 

  

 

 

Gambar 2.8 Lay Out View 

7. Mengaktifkan atau Menonaktifkan Layer ; 

Secara default, seluruh layer pada project akan ditampilkan pada window 

View. Hal tersebut ditunjukkan dengan tanda check  pada tiap tema. Hal ini 

berarti kita dapat melihat data spasial tersebut pada Table of Content. Untuk 

mengatur tema tertentu yang tidak ditampilkan, kita dapat membuat tema 

tersebut tampak atau tidak ( on atau off) dengan mengklik tanda check 

tersebut sehingga tanda check-nya tidak ditampilkan. Sebaliknya pula apabila 

kita ingin menampilkan kembali tema tersebut. 

8. Tool-Tool Pada Toolbar; 

ArcMap menyediakan beberapa Tool yang dapat digunakan agar bisa 

berinteraksi dengan data.  
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Adapun tool-tool tersebut adalah, gambarnya dapat dilihat pada Gambar 2.9; 

Gambar  2.9Tool-Tool Pada Toolbar 

Ketentuan Gambar; 

a. Zooming  

ArcGIS menyediakan fungsi Zooming (membesarkan dan mengecilkan) 

untuk merubah skala peta pada dokumen view. Kita dapat melakukannya 

dengan tiga cara yaitu menggunakan menu, button atau toolbar. 

b. Zoom to Full Extent. Button ini digunakan untuk melihat keseluruhan 

tema (seluruh data spasial akan ditampilkan). 

c. Zoom In. Button ini digunakan untuk perbesaran sekali dengan pusat 

view sebagai titik sentral. 

d. Zoom out. Button ini digunakan untuk perkecilan sekali dengan pusat 

view sebagai titik sentral. 

e. Zoom to Previous Extent. Button ini digunakan untuk menampilkan 

kembali keadaan zooming yang kita gunakan sebelumnya. 

f. Zoom to Next Extent. 

g. Tool Zoom In. Tool ini digunakan untuk perbesaran sekali dengan 

menempatkan posisi kursor sebagai titik sentral. Apabila button ini diklik 
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dan kursor ditempatkan pada peta kemudian diklik dan ditahan (click and 

drag) sambil membuat segi empat, maka akan ditampilkan bidang area 

yang kita pilih tersebut. 

h. Tool Zoom Out. Tool ini digunakan untuk perkecilan sekali dengan 

menempatkan posisi kursor sebagai titik sentral. Apabila button ini diklik 

dan kursor ditempatkan pada peta kemudian diklik dan ditahan (click and 

drag) sambil membuat segi empat, maka akan ditampilkan bidang area 

yang kita pilih tersebut. 

i. Pan Tool ini digunakan untuk menggeser-geser peta, dengan mengklik 

kiri dan menggeser pointer kearah yang diinginkan. 

j. Select Features Tool,Tool ini digunakan memilih features yang 

dinginkan. 

k. Select Elements Tool,Tool ini digunakan untuk memilih object grafik 

seperti garis, titik, label atau arah utara dan lainnya, dengan mengunakan 

tool ini biasa dilakukan pengubahan ukuran menggambar dan menghapus 

objek tersebut. 

l. Identifikasi Tool,Tool ini berguna untuk menampilkan informasi mengenai 

features yang dipilih, dengan cara sebagai berikut: 

a.  Klik Identify tools; 

b. Klik mouse dan arahkan pointer pada data yang akan diidentify; 

c.  Semua data yang ada pada visible layer akan diidentifikasi,gambarnya 

dapat dilihat pada Gambar 2.10; 
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Gambar 2.10 Identifikasi Tool 

m. Find Tool ini berguna untuk mencari informasi yang terdapat pada suatu 

feature digunakan untuk mencari berdasarkan informasi tertentu.  

Mencari data-data dengan atribut tertentu: 

a. Klik tombol Find pada toolbar tools; 

b. Klik Features tab; 

c. Ketik kata yang ingin ditampilkan pada kotak Find Text; 

d. Klik panah kebawah pada In kemudian klik layer yang diinginkan 

atau dapat dipilih Visible Layers; 

e. Beri tanda check box pada kotak Find Feaatures that aresimilar to or 

contain the search string; 

f. Pilih salah satu Option pada kolom yang akan di cari, contoh all 

fields; 

g. Kemudian Klik Find, gambarnya dapat dilihat pada Gambar 2.11; 
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Gambar2.11Mencari data-data menggunakan Find Tool 

n. Measure Tool. Tool ini berguna untuk mengukur jarak pada peta, jarak 

akan muncul sebagai panjang dari segment garis pada status bar, dengan 

tahapan sebagai berikut: 

 

2.8 DataGlobal Positioning System (GPS) 

Teknologi Global Positioning System(GPS) memberikan terobosan penting 

dalam menyediakan data bagi Sistem Informasi Geografis (SIG). Keakuratan 

pengukuran Global Positioning System(GPS) semakin tinggi dengan 

berkembangnya teknologi. Data ini biasanya direpresentasikan dalam format 

vektor. Pembahasan mengenai Global Positioning System(GPS) akan diterangkan 

selanjutnya. 

 

2.8.1  Metode penentuan posisi Global Positioning System (GPS)      

Global Positioning System (GPS) adalah sistem navigasi dan penentuan 

posisi menggunakan satelit yang dikembangkan dan dikelola oleh Departemen 

Pertahanan Amerika Serikat (DPAS). Global Positioning System(GPS) dapat 
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memberikan informasi tentangposisi, kecepatan dan waktu di mana saja di muka 

bumi setiap saat, dengan ketelitian penentuan posisi dalam fraksi milimeter 

sampai dengan meter. Kemampuan jangkauannya mencakup seluruh dunia dan 

dapat digunakan banyak orang setiap saat pada waktu yang sama (Abidin,H.Z, 

1995:17). 

 

2.8.2  Metoda-metoda penentuan posisi  Global Positioning System  (GPS) 

Pada dasarnya konsep dasar penentuan posisi dengan satelit Global 

Positioning System (GPS) adalah pengikatan kebelakangdengan jarak, yaitu 

mengukur jarak ke beberapa satelit teknologi Global Positioning System (GPS) 

yang koordinatnya telah diketahui. 

 

2.8.3  Lokasi titik nol dari sistem koordinat 

Posisi suatu titik di permukaan bumi umumnya ditetapkan dalam suatu 

sistem koordinat terestris. Titik nol dari sistem koordinat terestris ini dapat 

berlokasi di titik pusat massabumi (sistemkoordinat geosentrik), maupun di salah 

satu titik di permukaan bumi (sistem koordinat toposentrik). 

 

2.8.4  Sistem koordinat 

Posisi suatu titik biasanya dinyatakan dengan koordinat (dua dimensi atau 

tiga dimensi) yang mengacu pada suatu sistem koordinat tertentu. Sistem 

koordinat itu sendiri dapat didefinisikan dengan menspesfikasi tiga parameter 

berikut, yaitu: posisi, kecepatan dan waktu di mana saja di muka bumi setiap saat, 
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dengan penentuan posisi dalam fraksi milimeter sampai dengan meter. 

Kemampuan jangkauannya mencakup seluruhdunia dan dapat digunakan banyak 

orang setiap saat pada waktu yang sama (Abidin,H.Z, 1995:17). 

 

2.9 Tinjauan Umum Perusahaan 

 Perusahaan Daerah Air Minum ( PDAM)  merupakan unsur pelayanan umum 

dalam penyediaan pelayanan air bersih yang bertujuan untuk menyelenggarakan 

pengelolaan air bersih untuk meningkatkan kesejahteraan masyarakat yang 

mencakup aspek sosial, kesehatan dan pelayanan umum. Untuk meningkatkan 

kesejahteraan masyarakat Perusahaan Daerah Air Minum ( PDAM) Tirta Naga 

Kota Tapak Tuan memilki visi dan misi untuk membangun perusahaan yang telah 

dibentuk yaitu:  

1. Penyusunan kebijakan program Perusahaan Daerah Air Minum ( PDAM) . 

2. Memberikan pelayanan air minum kepada masyarakat Kota Tapak Tuan 

dengan meningkatkan kesejahteraan masyarakat. 

3. Penyelenggaraan pelayanan umum dan jasa. 

4. Pendataan pelanggan air bersih dan meningkatkan pendapatan daerah. 
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BAB III 
METODE PENELITIAN 

 
 

3.1 Tempat  Penelitian 

 Penelitian ini dilaksanakan di  Perusahaan Daerah Air Minum ( PDAM)  

Tirta Naga Kota Tapak Tuan di Desa Lhok Bengkuang, yang beralamat 

Jl.Sudirman Tapak Tuan Aceh Selatan. 

 

3.2 Keadaan Geografis Tempat Penelitian 

Wilayah Desa Lhok Bengkuang berada dalam Kecamatan Tapak Tuan 

Kabupaten Aceh Selatan. Secara Geografis Desa Lhok Bengkuang terletak antara 

05° 36’ 04” LU - 95° 36’ 04” BT dan 95 ° 43’ 37”BT - 05° 32’ 36” LU.Gambar peta 

satelit dapat dilihat pada Gambar 3.1; 

 

 

 

 

 

 

 

  Gambar 3.1 peta satelit Desa Lhok Bengkuang 

Wilayah Desa Lhok Bengkuang dibatasi oleh batas-batas sebagai berikut: 

1. Sebelah Barat  : Desa Lhok Ketapang 

2. Sebelah Selatan : Desa Padang 
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3. Sebelah Timur  : Desa Jambo Apa 

4. Sebelah Utara  : Desa Batu Itam 

Desa Lhok Bengkuang terdiri dari kawasan dataran rendah dan kawasan 

pegunungan. Kawasan dataran rendah meliputi kawasan tepi pantai dan 

pemukiman penduduk. Kawasan pergunungan terdiri dari kawasan dataran tinggi 

dan kawasan perbukitan. 

Jumlah Penduduk Desa Lhok Bengkuang Mencapai 4.751 jiwa dan terdiri 

dari 1.440 KK. Sumber mata pencarian pada umumnya dibidang perkebunan pala 

dan sebagian kecil yang menjadi nelayan, pedagang atau pegawai negeri. 

 

3.3 Bahan dan Alat Penelitian 

Sebelum melakukan pengumpulan data, secara terlebih dahulu penulis 

mempersiapkan seperti: 

a. Satu unit note book  yang sudah terinstal ArcGIS 9.3 agar dapat memudahkan 

mengolah data. 

b. Global Positioning System (GPS)  Garmin GPS 60.  

c. Kamera Digital. 

 

3.4 Prosedur Penelitian 

Dalam penelitian ini penulis menggunakan dua macam metode, yaitu:  

1. Observasi  lapangan 

Data  yang  diperoleh  berupa  data  primer  maupun  sekunder. Berdasarkan  

hasil  wawancara  dan  pengamatan  di  lapangan. Pengumpulan  data  
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secara  observasi  di  lakukan  pengamatan  di  lapangan secara  langsung 

seperti pengambilan titik koordinat, pengambilan gambar rumah pelanggan 

dan pengecekan pipa.  Adapun  data primer  penulis  peroleh  dari  kantor  

bagian  perancanaan  Perusahaan Daerah Air Minum ( PDAM)  Tirta Naga 

Kota Tapak Tuan seperti data-data pelanggan, kamera digital, dan peta 

lokasi Desa Lhok Bengkuang pada kawasan Lhok Bengkuang.  Sedangkan  

data  sekunder  diperoleh  dari  hasil  wawancara  dan  tanya  jawab  pada 

Staf Kepala Bagian  Badan  Perancanaan  Perusahaan Daerah Air Minum 

(PDAM) Tirta Naga Kota Tapak Tuan.Sebelum melakukan pengumpulan 

data, secara terlebih dahulu kita mempersiapkan seperti: 

a. Satu unit note book yang sudah terinstal ArcGIS 9.3 agar dapat 

memudahkan mengolah data dan memetakan wilayah. 

b. Global Positioning System (GPS) yang sudah dinyalakan dan sudah 

terkoneksi minimal dengan 4 satelit.  

Setelah semuanya disiapkan, maka prosedur kerja yang dilakukan 

pertama kali adalah mempelajari konsep dasar Sistem Informasi Geografi 

(SIG). Metode yang digunakan adalah metode survei lapangan yang 

diambil dengan menggunakan Global Positioning System (GPS). 

Sesampainya ditempat infrastruktur tersebut hal yang harus dilakukan 

adalah menghidupkan Global Positioning System (GPS) dan menunggu 

beberapa saat sampai terkoneksinya empat satelit (sebaiknya dilakukan 

pada hari cerah). Setelah muncul gambar yang menandakan 

terkoneksinya Global Positioning System (GPS) dan titik koordinat dari 
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tempat yang di survei tersebut lalu tekan tombol Markuntuk 

menandakan tempat/titik koordinat dari tempat infrastruktur yang akan 

diberi nama, setelah koordinatnya tersimpan maka tekan tombol Save  

untuk memberikan nama pada titik koordinat tersebut dan 

menyimpannya di dalam Global Positioning System (GPS). 

2. Digitasi onscreen di layar monitor 

Digitasi adalah sebuah kegiatan untuk merubah bentukan/feature geografi 

yang berasal dari peta analog ke bentuk digital dalam format GIS/SIG. Dalam 

digitasi onscreen paling sering dilakukan karena lebih mudah dilakukan, 

tidak memerlukan tambahan peralatan lainnya, dan lebih mudah untuk 

dikoreksi apabila terjadi kesalahan. Adapun objek-objek yang didigitasi 

merupakan, semua rumah yang ada di kawasan Lhok Bengkuang Kota Tapak 

Tuan melalui photo udara Tahun 2007 dengan menggunakan software 

ArcGIS 9,3. Digitasi ini direpresentasikan dalam betuk garis (Line/Polyline). 

 

3.5 Subsistem Sistem Informasi Geografis (SIG) 

Sistem Informasi Geografis (SIG) dapat diuraikan menjadi beberapa 

subsistem sebagai berikut: 

a. Data Input: Subsistem ini bertugas untuk mengumpulkan data dan 

mempersiapkan data spasial dan atribut dari berbagai sumber dan 

bertanggungjawab dalam mengkonversi atau mentransfortasikan format-format 

data-data aslinya kedalam format yang dapat digunakan oleh Sistem Informasi 

Geografis (SIG). 
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b. Data output: Subsistem ini menampilkan atau menghasilkan keluaran seluruh 

atau sebagian basis data baik dalam bentuk softcopy maupun bentuk hardcopy 

seperti: tabel, grafik dan peta. 

c. Data Management: Subsistem ini mengorganisasikan baik data spasial maupun 

data atribut ke dalam sebuah basis data sedemikian rupa sehingga mudah 

dipanggil, diupdate dan diedit. 

d. Data Manipulation & Analysis: Subsistem ini menentukan informasi-informasi 

yang dapat dihasilkan oleh Sistem Informasi Geografis (SIG) dan melakukan 

manipulasi serta pemodelan data untuk menghasilkan informasi yang 

diharapkan, gambarnya dapat dilihat pada Gambar 3.2; 

 

Gambar 3.2subsistem-subsistem SIG 

Jika subsistem Sistem Informasi Geografis (SIG) tersebut diperjelas 

berdasarkan uraian jenis masukan, proses, dan jenis keluaran yang ada 

didalamnya, maka subsistem Sistem Informasi Geografis (SIG) dapat juga 

digambarkan sebagai berikut, gambarnya dapat dilihat pada Gambar 3.3; 
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Gambar 3.3 subsistem-subsistem SIG 

Pada bagian ini penulis menggunakan dua software yang beroperasi di 

sistem Windows seperti: 

1. ArcMap Bagian dari software ArcGIS 9,3 yang dapat mengerjakan pengolahan 

data, menampilkan data, pembuatan peta dan cetak peta. 

2. ArcCatalog Bagian dari software ArcGIS 9,3 yang berfungsi sebagai katalog 

data, pembaca file, pengaturan sistem koordinat dan metadata. 

 

3.6 Perancangan Penelitian 

 Terdapat beberapa langkah dalam melakukan penelitian pengelolaan pada 

Perusahaan Daerah Air Minum ( PDAM) Tirta Tirta Naga Kota Tapak Tuan 

seperti terlihat pada Gambar 3.4; 

 

 

 

Studi Awal  



29 

 

 

 

 

 

 

 

 

Gambar 3.4 Langkah-langkah Penelitian 

1. Studi Awal 

Dalam melakukan studi awal, penulis melakukan pancarian materi, 

pembuatan serta mempelajari Sistem Informasi Geografis (SIG). 

2. Pengumpulan Data 

Pada tahap ini, penulis melakukan pengumpulan data yang diperoleh dengan 

cara wawancara dengan staf Perusahaan Daerah Air Minum ( PDAM) Tirta 

Naga Kota Tapak Tuan dan observasi lapangan di daerah Lhok Bengkuang. 

3. Pengolahan Data 

Pada tahap ini, penulis melakukan pengolahan data dari wawancara dengan 

staf Perusahaan Daerah Air Minum ( PDAM) Tirta Naga dan proses 

observasi lapangan di daerah Lhok Bengkuang.  Proses pengolahan data ini 

menggunakan software ArcGIS 9.3.  

4. Analisis Data 

Pengumpulan Data  

Kesimpulan dan Saran 

Analisis Data 

Pengolahan Data 
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Pada tahap ini, penulis melakukan analisis data yang telah diperoleh 

dariwawancara dengan staf dan hasil observasi lapangan di daerah Lhok 

Bengkuang  dengan menggunakan software ArcGIS 9.3. 

5. Kesimpulan dan Saran 

Pada tahap akhir, penulis membuat kesimpulan dan saran dari semua proses 

penelitian yang dilakukan. 
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BAB IV 

HASIL DAN PEMBAHASAN 

 
 

4.1  Pembahasan 

Berdasarkan pemetaan pipa pelanggan Perusahaan Daerah Air Minum 

(PDAM)  Tirta Naga di Desa Lhok Bengkuang Kota Tapak Tuan dengan  

menggunakan software ArcGIS 9,3, data-data yang diolah dalam Sistem Informasi 

Geografis (SIG) merupakan fakta-fakta yang ada dipermukaan bumi yang 

memiliki referensi keruangan baik referensi secara absolut maupun referensi 

secara relatif dan disajikan dalam sebuah peta. 

a. Referensi absolut  

Berarti suatu data yang memiliki referensi geografis (sudah memiliki koordinat 

tertentu dipermukaan bumi). Misalnya adalah data titik-titik yang diproleh 

dengan menggunakan  Global Positioning System (GPS). 

b. Referensi relatif  

Berarti suatu data yang memiliki referensi geografis. Data ini dapat digunakan 

jika sudah dikaitkan dengan data yang memiliki referensi geografis yang sudah 

diolah menjadi data Geographic Information System (GIS), digital dan jumlah 

gambar rumah yang ada pada photo udara yang di digitasi garis dan polygon 

dikaitkan dengan data yang ada di PDAM Tirta Naga Tapak Tuan. 
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4.2 Hasil Prosedur 

Pada pemetaan pipa air pelanggan Perusahaan Daerah Air Minum 

(PDAM)Tirta NagadiDesa Lhok BengkuangKota Tapak Tuan dengan 

menggunakan software ArcGIS 9,3, penulis melakukan beberapa macam cara 

untuk dapat menampilkan dan memberikan informasi yang akurat dalam 

melakukan pengecekan pipa pelanggan untuk kepentingan evaluasi, pengendalian 

dan pemantauan. Adapun cara-cara yang digunakan seperti:  

a. Pengumpulan data, data-data yang terkumpul diolah menjadi data Geographic 

Information System (GIS) digital, dengan cara digitasi garis dan polygon. 

b. Pendigitasian dilakukan diatas gambar rumah, jalan, dan pipa. 

Hasil untuk melakukan pemetaan pipa air pelanggan Perusahaan Daerah Air 

Minum ( PDAM) Tirta Naga di Desa Lhok Bengkuang Kota Tapak Tuan dengan 

menggunakan software ArcGIS 9,3 antara lain yaitu  membuka data spasial atau 

peta yang telah ada dengan ArcMap. 

1. klik Start > Programs > ArcGIS > ArcMap atau dengan klik icon ArcMap 

pada desktop, gambarnya dapat dilihat pada Gambar 4.1; 

 

Gambar 4.1 Tampilan menu/icon ArcMap 

2. Pada saat ArcMap dijalankan, maka akan terlihat kotak dialog startup yang 

akan memberikan pilihan untuk memulai sebuah sesi pekerjaan. Kita 
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dapatmemilih antara lain : membuka project baru (open new map), membuka 

format yang telah disediakan (template) atau membuka sebuah project 

document yang telah ada atau project yang telah dibuat sebelumnya, 

gambarnya dapat dilihat pada Gambar 4.2; 

 

Gambar 4.2 Hasil tampilan project ArcMap yang sudah ada 

3. Pilih An Existing Map, kemudian klik project document yang 

telah ada seperti (d:mengelola arcgis\peta gis PDAM.mxd) lanjutkan dengan 

klik OK, Gambarnya dapat dilihat pada Gambar 4.3; 

 

 

 

 

 

 

 

Gambar 4.3 project data GIS digital 

Berdasarkan pada gambar diatas, project data-data yang diolah menjadi data 

Geographic Information System (GIS) digital ialah titik-titik koordinat yang di 
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hasilkan dari Global Positioning System (GPS), dan pendigitasian pada rumah, 

jalandan pipa dengan cara digitasi  polyline dan polygon. 

4.3 Proses Pembuatan Sistem 

Langkah-langkah untuk melakukan proses pembuatan sistem dengan 

menggunakan software ArcGIS 9,3 antara lain yaitu  membuka data spasial atau 

peta yang telah ada dengan ArcMap. 

2. klik Start > Programs > ArcGIS > ArcMapatau dengan klik icon ArcMap 

pada desktop, gambarnya dapat dilihat pada Gambar 4.4; 

 

Gambar 4.4 Tampilan menu icon ArcMap 

3. Pada saat ArcMap dijalankan, maka akan terlihat kotak dialog startup yang 

akan memberikan pilihan untuk memulai sebuah sesi pekerjaan. Kita dapat 

membuka project baru (open new map), untuk memulai daril awal lalu klik 

OK, gambarnya dapat dilihat pada Gambar 4.5; 

 

 

 

Gambar 4.5 Tampilan project software ArcMapload data 
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4. Klik add data  pilih shp 00SumatraA.shp, 11batas kabupaten kotaA.shp 

dan 11batas kecamatanL.shp kemudian block lalu klik add, gambarnya dapat 

dilihat pada Gambar 4.6; 

 

Gambar 4.6 Tampilan add data untuk 11peta dasar Sumatra 

5. Tunggu proses add data dalam menampilkan peta dasar Sumatra, gambarnya 

dapat dilihat pada Gambar 4.7; 

 

Gambar 4.7 Tampilan  peta dasar Sumatra 



36 
 

 
 

6. Klik Add  data kembali  pilihimage Tapak Tuan kemudian block lalu klik 

add, gambarnya dapat dilihat pada Gambar 4.8; 

 

Gambar 4.8 Tampilan add data untuk Image Tapak Tuan 

7. Tunggu proses add data dalam menampilkan Image Tapak Tuan, gambarnya 

dapat dilihat pada Gambar 4.9. 

8. Klik fileSave 

 

 

 

 

Gambar 4.9 Tampilan  Image Tapak Tuan 

9. Klik tanda yang di tunjuk tanda panah untuk Memanggil ArcCatalog, 

gambarnya dapat dilihat pada Gambar 4.10; 
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Gambar 4.10 Tampilan ArcCatalog 

10. Klik kanan pada lokasi yg di inginkanNewpilih folder, gambarnya dapat 
dilihat pada Gambar 4.11. 

 

Gambar 4.11 Membuat folder Shapefile 

11. Pada folder klik kananNewShapefile lalu muncul Icon selanjutnya. 

12. Pada name ketikan nama shapefile & pada feature pilih polyline (garis). 

13. Klik EditIcon spatial reference akan muncul klik Select(gambarnya 

dapat dilihat pada Gambar, 4.12) kemudian 

 

 

 

Gambar 4.12 cara membuat nama Shapefile (nama lokasi yg di digitasi) 
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akan muncul Icon Browse For Coordinate System. Pada Icon ini tentukan name 

Coordinate System nya, gambarnya dapat dilihat pada Gambar 4.13; 

 

Gambar 4.13 nama Shapefile yang di tentukan 

14. Set proyeksi, pada penelitian ini penulis menggunakan Projected Coordinate 

System untuk daerah Tapak Tuan kita tentukan sistem koordinatnya adalah 

UTM (Universal Transverse Mercator)Zone 46N dengan datum WGS 

1984lalu klik ok, gambarnya dapat dilihat pada Gambar 4.14; 

 

Gambar 4.14 hasil Shapefile properties 
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15. Memanggil hasil Shapefileclose ArcCatalogkemudian Klik add data  
pada ArcMap, gambarnya dapat dilihat pada Gambar 4.15; 

 

 

 

 

 

 

Gambar 4.15 menampilkan hasil Shapefile di layer 

16. Selanjutnya kita akan melakukan pendigitasian pada photo rumah jalan dan 

pipa dengan menggunakan photo udara. 

17. Klik editor pada menu  dekstop > pilih start editing atau seperti pada icon di 

bawah ini,gambarnya dapat dilihat pada Gambar 4.16; 

 

 

 

 

 

 

Gambar 4.16 Tampilan menu untuk memulai pendigitasian 
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18.  Muncul icon selanjutnya, gambarnya dapat dilihat pada Gambar 4.17; 

 

Gambar 4.17 Tampilan menu untuk memilih lokasi yang digitasi 

19. Setelah muncul Icon, pilih salah satu lokasi yang ingin kita digitasi, 

kemudian klik OK, gambarnya dapat dilihat pada Gambar 4.18; 

 

Gambar 4.18 Tampilan jaringan yang sedang digitasi 

Lokasi layer 
yg di digitasi   

Jaringan  yang sedang di 
digitasi  
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20. Klik sketch tool atau icon yang di tunjukan tanda panah untuk melakukan 

pendigitasian, seperti gambar di atas yang sudah didigitasi dengan rapi dan 

bagus susunannya. 

21.  Setelah pendigitasian selesai klik menu Editor pada dekstop (seperti langkah 

ke 6 ) > pilih save edits (untuk menyimpan yang baru di digitasi ). 

22. Setelah di simpan klik lagi Editor > klik stop editing untuk mengakhiri 

pendigitasian.    

 

4.3. 1layout dan pencetakan peta 

Langkah- langkah untuk menglayout peta adalah sebagai berikut: 

1. Klik  Layout View dengan klik View >Layout View. Atau klik ikon di 

bagian bawah halaman data, gambarnya dapat dilihat pada Gambar 4.19; 

 

 

 

 

 

 

 

Gambar 4.19 Tampilan untuk layout peta 
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2. Setelah mengganti ke Layout View, maka peta akan disajikan pada halaman  

layout. Halaman layout ini menyajikan satu atau lebih data frame, gambarnya 

dapat dilihat pada Gambar 4.20; 

 

Gambar 4.20 halaman layout 

3. Layout toolbar memuat tools yang dipakai untuk mengedit layout. 

Tools tersebut antara lain zoom in, zoom out, pan dan beberapa 

tools standar lain, gambarnya dapat dilihat pada Gambar 4.21; 

 

 

 
 

 

 

 

Gambar 4.21layout toolbar 

Zoom in/  
zoom out  
 

Fixed  
Zoom in/  
zoom out  
 

Zoom 
100%  
 

Go to Next  
Extent/  
Previous Extent  
 

Toggle Draft  
Mode  
 Change  

Layout  
 

Pan  
 

Zoom  
Whole Page  

Zoom 
Control  

Focus Data 
Frame  
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a. Zoom in/Zoom out : Memperbesar atau memperkecil peta pada layer yang 

aktif di halaman layout.  

b. Pan : Menggerakkan peta pada layer yang aktif di halaman layout.  

c. Fixed zoom in/zoom out : Memperbesar atau memperkecil peta pada layer 

yang aktif dengan skala yang diberikan langsung oleh ArcMap.  

d. Zoom Whole Page : Menampilkan seluruh halaman layout.  

e. Zoom 100% : Menampilkan peta yang aktif dengan skala 1:1. 

f. Go to next extent/previous extent : Ketampilan peta sebelum atau sesudah.  

g. Zoom control : Menampilkan peta dengan skala perbesaran yang 

diinginkan pengguna.  

h. Toggle Draft mode : Digunakan untuk membuat layout tanpa tampilan 

peta, sehingga pengguna tidak perlu menunggu gambaran peta. Pada 

toggle draft mode, peta diwakili dengan judul layer.  

i. Focus data frame : Untuk fokus pada salah satu data frame.  

j. Change layout : Untuk mengubah layout. Pengguna dapat memilih 

template peta yang diinginkan. Perlu dicatat bahwa setiap project  pada 

ArcGIS hanya dapat menyajikan satu layout.  

 

4.3.2 Mengatur Proyeksi 

1. Klik kanan pada layer yang aktif, lalu klik Properties >Data Frame 

Properties >Coordinate System.  

2.  Akan muncul kotak Data Frame Properties >Coordinate System.  
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3. Pada Kotak Select a coordinate system, pilih Predefined >Projected 

Coordinate System >UTM >WGS1984 UTM Zone 46N, gambarnya 

dapat dilihat pada Gambar 4.22; 

 

 

 

 

 

 

 

 

Gambar 4.22 mengatur proyeksi peta 

 

4.3.3Mengatur Halaman Layout 

1. Untuk mengatur lebar halaman. Klik kanan halaman pada halaman layout 

lalu pilih Page and Print Setup. Akan muncul kotak Page and Print Setup  

2. Kotak dialog Page and Print Setup digunakan untuk mengubah orientasi 

portrait menjadi landscape atau sebaliknya. Ukuran halaman dapat diubah 

dengan mengeditnya di kotak properties.  

3. Elemen-elemen penting lain yang wajib dicantumkan pada sebuah peta, 

antara lain adalah skala, legenda, panah penunjuk arah, judul dan koordinat 

peta, gambarnya dapat dilihat pada Gambar 4.23; 
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Gambar 4.23 mengatur halaman layout 

4.3.4  Langkah-langkah untuk Menambahkan Skala 

1. Klik Insert >Klik Scale Bar untuk menambahkan skala, gambarnya dapat 

dilihat pada Gambar 4.24; 

 

 

 

 

 

Gambar 4.24Scale Bar 

2. Kotak dialog Scale Bar Selector akan muncul. Skala dapat diedit dengan 
mengklik Properties, gambarnya dapat dilihat pada Gambar 4.25; 

 
 
 
 
 
 
 

Gambar 4.25beberapa macam bentuk skala 
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3. Selanjutnya kotak dialog North Arrow Selector akan muncul. Panah 

penunjuk arah dapat diedit dengan mengklik tombol Properties. 

4. Pilih Panah penunjuk arah yang diinginkan, lalu klik Ok.  

5. Klik panah penunjuk arah, tarik ke halaman kosong di halaman layout, 

gambarnya dapat dilihat pada Gambar 4.26; 

 

 

 

 

 

 

     Gambar 4.26panah penunjuk arah 

 

4.3.5Menambahkan Judul Peta 

1. Klik menu Insert >Title, gambarnya dapat dilihat pada Gambar 4.27;  

 

 

 

 

  Gambar 4.27menambahkan judul 

2. Tulis judul yang mewakili peta pada kotak judul. Untuk mengubah bentuk 

dan ukuran judul sesuai kebutuhan, klik kanan pada kotak judul dan pilih 
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Properties. Setelah itu akan muncul kotak Properties. Ketiklah judul pada 

kolom text yang telah disediakan. Geographic Information System (GIS) 

Konsorsium. 

 

4.3.6 Menambahkan Legenda 

1. Klik menu Insert >Legend. 

2. Kotak dialog Legend Wizard akan muncul. Kotak ini akan membimbing 

melalui 5 tahap dalam membuat legenda sesuai dengan yang diinginkan.  

a) Tahap pertama memilih data-data yang ingin ditampilkan pada kotak 

legenda. Pilih data yang diinginkan untuk ditampilkan di kotak legenda. 

Klik Next, gambarnya dapat dilihat pada Gambar4.28; 

 

 

 Gambar 4.28 menambahkan judul 

b) Tahap kedua untuk membuat judul legenda sesuai dengan yang 

diinginkan, gambarnya dapat dilihat pada Gambar 4.29; 

 

 

 

 

 

Gambar 4.29 menambahkan judul sesuai di inginkan 
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c) Tahap ketiga adalah untuk membuat kotak legenda sesuai yang di 

ingikan, klik menu drop down border untuk menambah bingkai kotak 

legenda. Pilih border garis hitam dengan ketebalan 3. klik menu drop 

down backdround untuk memilik warna latar. Pilih warna latar olive, 

gambarnya dapat dilihat pada Gambar 4.30; 

 

Gambar 4.30membuat kotak legenda 

d) Tahap keempat untuk mengedit ukuran dan bentuk lambang yang 

mewakili setiap data sesuai yang diinginkan pengguna. Misalnya, 

lambang untuk data persil dapat diubah ukurannya dan bentuknya 

menjadi oval, lingkaran atau kotak, gambarnya dapat dilihat pada 

Gambar 4.31; 

 

 

 

 

 

                              Gambar 4.31 untuk mengedit ukuran dan bentuk lambang 
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e) Tahap terakhir menentukan jarak antara bagian-bagian yang disajikan 

pada legenda peta. Klik Finish setelah menyelesaikan Legend Wizard, 

gambarnya dapat dilihat pada Gambar 4.32; 

 

Gambar 4.32untuk menentukan jarak 

f) Berikut tampilan layout yang telah selesai, gambarnya dapat dilihat 
pada Gambar, 4.33; 

 

 

 

 

 

 

 

 

 

Gambar 4.33peta yang sudah dilayout 
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BAB V 
KESIMPULAN DAN SARAN 

 
 

5.1 Kesimpulan 

Adapun yang menjadi kesimpulan dan saran dari penulis yaitu: 

1. Dari hasil penelitian lapangan yang penulis lakukan di Perusahaan Daerah 

Air Minum ( PDAM) Tirta Naga Tapak Tuan menggunakan software ArcGIS 

9,3 dapat menampilkan lokasi  pipa dan rumah pelanggan. 

2. Dari hasil penelitian lapangan yang penulis lakukan di Perusahaan Daerah 

Air Minum ( PDAM) Tirta Naga Tapak Tuan, software ArcGIS 9,3 lebih 

unggul dari pada sistem informasi yang sebelumnya dilakukan secara manual 

oleh Perusahaan Daerah Air Minum ( PDAM) Tirta Naga Tapak Tuan, dalam 

melakukan pengecekan jaringan pipa untuk kepentingan evaluasi, 

pengendalian dan pemantauan pelanggan yang bermasalah. 

3. Berdasarkan pengamatan penulis selama berada di tempat penelitian 

lapangan, dimana pengambilan titik koordinat di Desa Lhok Bengkuang 

dengan menggunakan Global Positioning System (GPS) dapat memberikan 

kemudahan dalam mengidentifikasi posisi dari suatu lokasi dalam Sistem 

Informasi Geografis (SIG) yang dihasilkan dari software ArcGIS 9,3. 

 

5.2 Saran 

Adapun saran-saran yang ingin penulis kemukakan sebagai berikut: 

1. Untuk pengoperasian perangkat lunak ArcGIS 9,3 yang digunakan di 

Perusahaan Daerah Air Minum ( PDAM)Tirta Naga Tapak Tuan, perlu di 
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terapkan kepada seluruh Staf-Staf BagianPerusahaan Daerah Air Minum 

(PDAM) Tirta Naga untuk memudahkan mangakses informasi dari data-data 

yang di butuhkan sesuai dengan perkembangan sistem informasi sekarang ini. 

2. Penulis menyarankan pengembangan atau penelitian yang lebih lanjut pada 

software ArcGis 9,3, peneliti harus bisa membuat satu fungsi pencarian yang 

komplit demi pengguna yang tidak mengerti tentang ArcGis. 

3. Penulis menyarankan untuk melakukan pengembangan terhadap data 

pelanggan secara menyuluruh dan terintegrasi. 
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